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1PRIME (Ver. 2.2)-IV (Answer Key)

	Computer Memory

Rapid Fire

1.	 a.	 (iii)	 b.	 (i)	 c.	 (ii)	 d.	 (iii)	 e.	 (i)
2.	 a.	 Computer memory	 b.	 Flash Drive	 c.	 Memory Card
	 d.	 Hard Disk

Evaluation Time

1.	 a.	 USB	 b.	 Byte	 c.	 Optical Disc	 d.	 Zettabyte
2.	 a.	 There are two types of memory: Primary memory and Secondary memory. 
	 	 • � Primary memory is the main memory of a computer. CPU can directly access this 

memory. 
	 	 •  Secondary memory is permanent in nature and is not directly accessed by the CPU.
	 b.	� i. � Pen drive acts as a portable hard drive and is easy to use as it is small and can be carried 

in a pocket and plugged into any computer with a USB drive. 
	 	 ii.   �An optical disc is an electronic data storage medium that can be used to write and read 

using a low-powered laser beam. 
	 c.	 RAM is a temporary memory whereas, ROM is a permanent memory.
	 d.	 Blu-ray disc is an optical disc. It is used for storing a large amount of data and playing videos.
3.	 a.	 Ramesh is likely facing issues due to volatile memory (RAM), which loses data when power 

is lost. He should frequently save work and consider using auto-save features or a UPS to 
prevent sudden shutdowns.

	 b.	 Anil can manage storage by deleting unused apps, clearing cache, and moving files to cloud 
or SD card. External storage like SD cards helps expand space without deleting important 
data.

Activity Time

1.	 a.	 1	 b.	 4	 c.	 2	 d.	 3
2.	 a.	 MEMORY			   b.	 COMPACT DISC
	 c.	 STATIC RAM			   d.	 HARD DISK

1.



2 PRIME (Ver. 2.2)-IV (Answer Key)

In The Lab

Do it yourself.

	More About Windows 10

Rapid Fire

1.	 a.	 (ii)	 b.	 (i)	 c.	 (i)
2.	 a.	 F	 b.	 T	 c.	 T

Evaluation Time

1.	 a.	 Live	 b.	 This PC	 c.	 Apps
2.	 a.	 Start menu displays a list of all the application installed in the computer. It also displays the 

live tiles. 
	 b.	 Taskbar is a long horizontal bar located at the bottom of the desktop. It helps to manage 

various currently active programs, opened in different windows.
	 c.	� Recycle bin is a place in the memory where all the deleted files are stored temporarily before 

being deleted permanently.
	 d.	 To remove a tile, follow the given steps: 
	 	 Step 1:	 Right-click on the tile. 
	 	 Step 2:	 Choose the option Unpin from Start. The tile will be removed. 
3.	 a.	 Ethan should right-click the application on the Taskbar and select ‘Unpin from taskbar’; this 

removes it from the Taskbar but keeps it in the Start menu.
	 b.	 Olivia can look at the icons on the Taskbar—all currently open programs are shown there 

with an underline or highlight. 

Activity Time

1.	 a.	 Windows key + E		  b.	 Windows key + S
2.	 a.	 Operating System		 b.	 This PC
	 c.	 Taskbar	 d.	 Recycle Bin

In The Lab

Do it yourself.

2.



3PRIME (Ver. 2.2)-IV (Answer Key)

(Based on chapters 1 & 2)
Periodic Assessment 1

A.	 1.	 MEMORY	 2.	 FOLDER	 3.	 FILE EXPLORER
	 4.	 COMPACT DISC	 5.	 RECYCLE BIN	 6.	 STATIC RAM	
	 7.	 HARD DISK	 8.	 LIVE TILES	 9.	 FILE
B.	 1.	 Pen drive	 2.	 Compact Disc	 3.	 Hard Disk	
	 4.	 RAM	 5.	 Memory Card	 6.	 ROM
C.	 1.	 Storage Devices	 2.	 Start Menu	 3.	 File Explorer	 4.	 Recycle Bin	 5.	 Folder

	Tables in Word 2016

Warm
Up! 	 a. (ii)	 b. (iii)	 c. (iv)	 d. (i)

Rapid Fire

1.	 a.	 (i)	 b.	 (iii)	 c.	 (ii)	 d.	 (iii)	 e.	 (ii)
2.	 a.	 T	 b.	 F	 c.	 T	 d.	 F	 e.	 T

Evaluation Time

1.	 a.	 Columns	 b.	 Rows	 c.	 Quick Tables	 d.	 Merging Cells
2.	 a.	 To select a column, hover your mouse in the column selection area at the top of a column. 

The mouse pointer changes to a downward pointing arrow then click on the column to 
select it.

	 b.	 To insert a quick table, follow these steps:
	 	 Step 1:	 Click on Insert tab.
	 	 Step 2:	 Click on Table drop-down arrow in Tables group.
	 	 Step 3:	 Select Quick Tables.
	 	 Step 4:	 Select the table template according to your choice.
	 c.	 To merge cells of a table, follow these steps:
	 	 Step 1:	 Select the cells that you want to merge.
	 	 Step 2:	 Click on Layout tab under Table Tools.
	 	 Step 3:	 Click on Merge Cell command in the Merge group.

3.



4 PRIME (Ver. 2.2)-IV (Answer Key)

	 d.	 To apply a table style, follow the given steps:
	 	 Step 1:	 Click anywhere in the table. 
	 	 Step 2:	 Click on Design tab under Table Tools.
	 	 Step 3:	 Click on the desired style in the Table Styles group.
	 	 Step 4:	 Click on More button to see more styles. 
	 	 Step 5:	 Click on the style.
	 e.	 To create a table using graphic grid, follow the given steps: 
	 	 Step 1:	 Click on Insert tab. 
	 	 Step 2:	 Click on Table drop-down arrow in Tables group. A table drop-down menu appears. 
	 	 Step 3:	� Click on the top left corner of the grid and drag the mouse to highlight the number 

of columns and rows you want in the table. 
	 	 When you release the mouse button, the table appears in the document and two new tabs 

appear on the ribbon. 
3.	 a.	 To merge cells in a table and create a title row for his project, Ravi can follow these steps:
	 	 Step 1:	 Select the cells that you want to merge.
	 	 Step 2:	 Click on the Layout tab under Table Tools.
	 	 Step 3:	 Click on the Merge Cells command in the Merge group.
	 	 Ravi can find the Merge command in the Merge group under the Layout tab.
	 b.	 To insert rows or columns in a table, Samira can follow the given steps: 
	 	 Step 1:	 Click on Insert tab.
	 	 Step 2:	 Click on Table drop-down arrow in Tables group.
	 	 Step 3:	 Click on Insert Table option. The Insert Table dialog box appears.
	 	 Step 4:	 Enter the number of columns as 4 and Number of rows as 6.
	 	 Step 5:	 Click on the OK button. The table appears in the document.
	 c.	 She can format the header row to make it bold by following these steps:
	 	 Step 1:	 Select the entire header row by clicking on the row header.
	 	 Step 2:	 Click the Bold button in the Home tab of the ribbon.

Activity Time

	 a.	 table			   b.	 layout, table tools	
	 c.	 delete, drop-down menu	 d.	 delete table, deleted

In The Lab

Do it yourself.



5PRIME (Ver. 2.2)-IV (Answer Key)

	Shapes, Graphics and Pictures in Word 2016

Warm
Up! 	

Rapid Fire

1.	 a.	 (i)	 b.	 (i)	 c.	 (ii)	 d.	 (iii)
2.	 a.	 T	 b.	 F	 c.	 T	 d.	 F

Evaluation Time

1.	 a.	 Text Outline	 b.	 Pictures	 c.	 Insert	 d.	 Format
2.	 a.	 WordArt is the special effect in Word to change the appearance of the text.
	 	 To add effect to the text, follow these steps:
	 	 Step 1:	 In the WordArt Styles group, click on the Text Fill command.
	 	 Step 2:	 Select the color or gradient effect for the WordArt text.
	 b.	� The Shapes command contains several categories of shapes, like lines, basic shapes, flow 

chart elements, stars and banners, and callouts. To add text in a shape, follow these shapes:
	 	 Step 1:	 Right-click inside the shape.
	 	 Step 2:	 Select Add Text option.
	 	 Step 3:	 Type the text and then click anywhere on the screen outside the shape.
	 c.	 To insert an online picture, follow these steps:
	 	 Step 1:	 Click on Insert tab.
	 	 Step 2:	 Click on Pictures command in the Illustration group.
	 	 Step 3:	 Click on the Online Pictures option.
	 	 Step 4:	 Type a word in Bing Image Search box.
	 	 Step 5:	 Select the picture, you want to insert. Click on the Insert (1) button.
3.	 a.	 Nikhil can use the Pictures command under the Insert tab.
	 b.	 Amit can use the Shapes command in the Illustrations group in the Insert tab. He can use 

the Text Effects command in the WordArt Styles group to add a shadow effect.

Activity Time

	 a.	 Shapes	 b.	 Reflection	 c.	 WordArt	 d.	 Shape Fill

Find Out  
Do it yourself.

4.



6 PRIME (Ver. 2.2)-IV (Answer Key)

In The Lab

Do it yourself.

(Based on chapters 3 & 4)
Periodic Assessment 2

A.	 1.	 Glow	 2.	 Reflection
B.	

January February March

April May June

July August September

October November December

C.	
Delete Insert

Below
Insert
Right

Insert
Above

Insert
Left

D.	 1. T	 2. T	 3. T	 4. F	 5. T	 6. F	 7. F

(Based on chapters 1 to 4)

Test Sheet  1

Section A
A.	 1.	 (i)	 2.	 (iii)	 3.	 (i)	 4.	 (i)	 5.	 (i)	 6.	 (iii)
	 7.	 (i)	 8.	 (ii)
B.	 1.	 USB	 2.	 Zettabyte	 3.	 Columns
	 4.	 Quick Tables	 5.	 Insert
C.	 1.	 T	 2.	 T	 3.	 T	 4.	 T
D.	 1.	 ii	 2.	 iii	 3.	 iv	 4.	 i



7PRIME (Ver. 2.2)-IV (Answer Key)

Section B
A.	 1.	 Blu-ray disc is an optical disc. It is used for storing a large amount of data and playing videos. 
	 2.	� Recycle bin is a place in the memory where all the deleted files are stored temporarily before 

being deleted permanently. 
	 3.	 To insert a quick table, follow these steps: 
	 	 Step 1:	 Click on Insert tab. 
	 	 Step 2:	 Click on Table drop-down arrow in Tables group. 
	 	 Step 3:	 Select Quick Tables. 
	 	 Step 4:	 Select the table template according to your choice.
	 4.	 To apply a table style, follow the given steps: 
	 	 Step 1:	 Click anywhere in the table. 
	 	 Step 2:	 Click on Design tab under Table Tools. 
	 	 Step 3:	 Click on the desired style in the Table Styles group. 
	 	 Step 4:	 Click on More button to see more styles. 
	 	 Step 5:	 Click on the style. 
	 5.	 WordArt is the special effect in Word to change the appearance of the text. 
B.	 1.	 •  Random Access Memory (RAM) is a temporary memory.
	 	 •  It is also called volatile memory.
	 	 •  RAM temporarily stores data and instructions.
	 	 •  Read-Only Memory (ROM) is permanent in nature.
	 	 •  It is also called non-volatile memory.
	 	 •  ROM holds the starting instructions required to start a computer.
	 2.	 To remove a tile, follow the given steps: 
	 	 Step 1:	 Right-click on the tile. 
	 	 Step 2:	 Choose the option Unpin from Start. The tile will be removed. 
	 3.	 To create a table using graphic grid, follow the given steps: 
	 	 Step 1:	 Click on Insert tab. 
	 	 Step 2:	 Click on Table drop-down arrow in Tables group. A table drop-down menu appears. 
	 	 Step 3:	� Click on the top left corner of the grid and drag the mouse to highlight the number 

of columns and rows you want in the table. 
	 	 When you release the mouse button, the table appears in the document and two new tabs 

appear on the ribbon. 
	 4.	 The Shapes command contains several categories of shapes, like lines, basic shapes, flow 

chart elements, stars and banners, and callouts. To add text in a shape, follow these shapes: 
	 	 Step 1:	 Right-click inside the shape. 
	 	 Step 2:	 Select Add Text option. 
	 	 Step 3:	 Type the text and then click anywhere on the screen outside the shape. 



8 PRIME (Ver. 2.2)-IV (Answer Key)

	 5.	 To insert an online picture, follow these steps: 
	 	 Step 1:	 Click on Insert tab. 
	 	 Step 2:	 Click on Pictures command in the Illustration group. 
	 	 Step 3:	 Click on the Online Pictures option. 
	 	 Step 4:	 Type a word in Bing Image Search box. 
	 	 Step 5:	 Select the picture, you want to insert. Click on the Insert (1) button. 

	Introduction to PowerPoint 2016

Warm
Up! 	 1.  Zoom slider		  2.  Placeholder

			   3.  Speaker’s Notes pane	 4.  Ribbon

Warm
Up! 	 1.  Title layout		  2.  Title Slide

			   3.  Two Content layout	 4.  Comparison layout 

Rapid Fire

1.	 a.	 (i)	 b.	 (iii)	 c.	 (i)	 d.	 (ii)	 e.	 (ii)
2.	 a.	 iii	 b.	 v	 c.	 iv	 d.	 i	 e.	 ii
3.	 a.	 T	 b.	 F	 c.	 T	 d.	 T

Evaluation Time

1.	 a.	 Slide Show View			  b.	 Normal View
	 c.	 Notes Page View		  d.	 Slide Sorter View
2.	 a.	 PowerPoint 2016 is a program that allows you to create interesting and exciting presentations.
	 b.	 To save a presentation, follow these steps:
	 	 Step 1:	 Click on File tab.
	 	 Step 2:	 Select Save or Save As command.
	 	 Step 3:	 Select This PC option and click on Browse option.
	 	 Step 4:	 Select the location of the file.
	 	 Step 5:	 Click in the File name: box and type a name for the file.
	 	 Step 6:	 Click on Save button.
	 c.	 Slide layout refers to the formatting and positioning of placeholder boxes for the content 

that appears on a slide.

5.



9PRIME (Ver. 2.2)-IV (Answer Key)

	 	 PowerPoint 2016 includes nine built-in slide layouts:
	 	 Title Slide layout, Title and Content layout, Section Header layout, Two Content layout, 

Comparison layout, Title Only layout, Blank layout, Content with Caption layout, and Picture 
with Caption layout.

	 d.	 Slide sorter shows the miniature version of all slides. Here, we can easily change the order of 
the slides. The advantage of this view is that you can see more of your slides on the screen 
and you can move, delete, edit and recognise these slides with greater ease 

	 	 Reading view is used when you want to view a presentation not in full screen but in a window 
with simple controls that make the presentation easy to review. The Reading View shows 
the presentation in full screen with the Title Bar and Status Bar and simple controls.

	 e.	 To insert a picture from a file, follow the given steps: 
	 	 Step 1:	 Click on the Insert tab. 
	 	 Step 2:	 Click on the Pictures option. 
	 	 Step 3:	 Browse the location where you have saved your picture file. 
	 	 Step 4:	 Select the desired picture file. 
	 	 Step 5:	 Click Insert button. 
	 	 The selected picture gets inserted in the slide.
3.	 a.	 To start the slide show in full screen in PowerPoint 2016, follow these steps:
	 	 Step 1:	 Click on the Slide Show tab.
	 	 Step 2:	� Select From Beginning command to start from the first slide or From Current Slide 

command to start from the slide you are on.
	 b.	 To insert a new slide, follow these steps: 
	 	 Step 1:	 Click on Home tab. 
	 	 Step 2:	 Click on the New Slide drop-down arrow in the Slides group. 
	 	 Step 3:	 Select the type of slide you want. A new slide is inserted. 

Activity Time

1.	 a.	 Slide Show			   b.	 Nine
	 c.	 Slide area			   d.	 Reading View
2.	 a.	 PRESENTATION			  b.	 POWERPOINT			   c.	 PLACEHOLDER
	 d.	 TITLE SLIDE			   e.	 OUTLINE PANE

Find Out  
Do it yourself.

In The Lab

Do it yourself.



10 PRIME (Ver. 2.2)-IV (Answer Key)

	Visual Processing

Warm
Up! 	

3

2

1

A B C

CatA1

B3

A3

A2 TreeCloud

Moon

Rapid Fire

	 a.	 (i)	 b.	 (iii)	 c.	 (i)

Evaluation Time

1.	 a.	 The ability of the brain to use and understand visual information from the environment is 
referred to as visual processing.

	 b.	 Directions and Maps help us by pointing to the location of a particular area or object. There 
are four main directions—North, East, West, and South. We can also locate an object on a 
map using a spot.

2.	 a.	 The butterfly is the odd one out because the other three (apple, banana, and mango) are 
fruits, while a butterfly is an insect.

	 b.	 Five Visual Landmarks on the Way to School:
	 i.	 A park			   ii.	 A school building		 iii.	 A hospital
	 iv.	 A bus stop			   v.	 A shopping mall

Activity Time
NORTH

East

SOUTH

WEST

6.



11PRIME (Ver. 2.2)-IV (Answer Key)

In The Lab

Do it yourself.

(Based on chapters 5 & 6)
Periodic Assessment 3

A.

	 			       

3

2

1

A B C

Bush Apple Dustbin

B.	

Speaker’s Notes PaneStatus Bar

Slides/ 
Outline Pane

Quick Access Toolbar Title Bar

Ribbon

C.	 Slide Sorter View

B2 B3 A2



12 PRIME (Ver. 2.2)-IV (Answer Key)

	More Blocks in Scratch

Warm
Up! 	 1 think for seconds2Hmm...

4 say for seconds2Who

5 say for seconds2You can speak owl language?

2 say for seconds2knock knock!

3 say for seconds2Who's there?

Rapid Fire

1.	 a.	 (i)	 b.	 (ii)	 c.	 (i)	 d.	 (iii)
2.	 a.	 Rotate the sprite 15 degrees			   b.	 Set volume of the sprite to 100%
	 c.	 Display the message for 2 seconds		  d.	 Repeats the blocks for 10 times
3.	 a.	 T	 b.	 T	 c.	 F	 d.	 T

Evaluation Time

1.	 a.	 Say	 b.	 Go To	 c.	 Sound	 d.	 Events
2.	 a.	 You can use the say block from the Looks category. The say Hello! for 2 seconds block will 

make the sprite display “Hello!” in a speech bubble for 2 seconds.
	 b.	 The forever block keeps repeating a set of blocks until the stop button is clicked.
	 c.	 The turn  15 degrees block from the Motion category is used to rotate the sprite 15 degrees 

clockwise.
	 d.	� Control blocks have looping blocks which are used when the same blocks have to be repeated 

for a number of times. The most commonly used control blocks are Wait and Repeat.
3.	 a.	 To achieve this in Scratch, you need the following blocks: When Green Flag Clicked and Set 

Size to 150%.
		  Script structure:

	 	
	 b.	 To make the sprite move continuously until it reaches the edge, Aarav needs the following 

blocks: When Green Flag Clicked, Repeat Until, Touching edge, and move 10 steps.

7.



13PRIME (Ver. 2.2)-IV (Answer Key)

		  Script structure:

	 	

Find Out

Do it yourself.

Activity Time

M

O

T

I

O

N

C

C

O

L

U

M

N

O

S

R

P

B

B

O

N

E

V

E

N

T

S

T

N

O

N

P

O

M

R

S XG

P OA

Z RT

X KO

R WR

U LC

O AL

I MO

E RT

U TI

T SO

O RA

F CP

L TD

N O

R S

R O

L U

W N

L D

G A

In The Lab

Do it yourself.

	More About Internet

Warm
Up! 	 Do it yourself.

Rapid Fire

1.	 a.	 (i)	 b.	 (ii)	 c.	 (iii)	 d.	 (ii)	 e.	 (iii)
2.	 a.	 T	 b.	 F	 c.	 F	 d.	 F	 e.	 F

8.



14 PRIME (Ver. 2.2)-IV (Answer Key)

Evaluation Time

1.	 a.	 Internet	 b.	 WWW	 c.	 Home Page	 d.	 Web	 e.	 Web browsers
2.	 a.	� ARPA set up a network of computers between different offices of defence department 

to exchange and share important information. This network of computers was called the 
Advanced Research Projects Agency Network or ARPANET.

	 b.	� ISP is a company that provides you the Internet connection and services for an annual or 
monthly fee. BSNL and MTNL are the examples of ISPs.

	 c.	� Getting the data from the host computer (server) to the client computer (user’s computer) 
is known as downloading. Copying the data from the client computer (user’s computer) to 
the host computer (server) is known as Uploading.

	 d. 	� Microsoft Edge is the default web browser in the Windows 10 operating system. Current 
tabs, Address bar and Refresh are the parts of Microsoft Edge.

3.	 a.	 Divya can use the Favourites feature of the Microsoft Edge web browser to save web pages 
for easy access later.

	 b.	 HTTP stands for HyperText Transfer Protocol and transfers data without encryption, making 
it less secure. HTTPS stands for HyperText Transfer Protocol Secure and encrypts the data, 
making it safe for sending personal or sensitive information online.

Activity Time

	 a.	 ARPANET	 b.	 MICROSOFT EDGE	 c.	 HYPERLINK
	 d.	 INTERNET	 e.	 SEARCH ENGINE

Find Out

Do it yourself.

In The Lab

Do it yourself.

	Evolution of AI

Warm
Up! 	 1.  WABOT		  2.  ASIMO

Rapid Fire

1.	 a.	 (i)	 b.	 (ii)	 c.	 (iii)	 d.	 (iii)
2.	 a.	 F	 b.	 T	 c.	 F	 d.	 F

9.



15PRIME (Ver. 2.2)-IV (Answer Key)

Evaluation Time

1.	 a.	 Mars Exploration Mission 
	 	 The two rovers used in that mission were Spirit and Opportunity.
	 b.	� Roomba, an autonomous robot vacuum cleaner that cleans and is able to avoid crashing 

into obstacles. 
	 c.	� It uses AI to act as a personal assistant helping the user remember tasks, create appointments, 

and search for information by voice. 
	 d.	� It uses a natural language user interface to infer, observe, answer, and give recommendations 

to users.
2.	 a.	 Yes, a self-driving car can be a good option. 
	 	 Reasons:
	 	 •  Increases safety by reducing human errors in driving. 
	 	 •  Uses AI-powered navigation for smooth and efficient travel. 
	 b.	 Kinect

Activity Time

	 a.	 David Hanson			   b.	 Cynthia Breazeal
	 c.	 Ichiro Kato			   d.	 Alan Turing 

In The Lab

Do it yourself.

(Based on chapters 7 to 9)
Periodic Assessment 4

A.	
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B.	 1.	 World Wide Web
	 2.	 Home Page is the first page of a website.
	 3.	 Getting the data from the host computer to client’s computer is know as downloading.
	 4.	 Sounds blocks is used to add music to the Scratch projects.
	 5.	 Motion blocks is used for rotating the Sprite.
C.	 1.	 Kismet	 2.	 WABOT-2

(Based on chapters 5 to 9)

Test Sheet  2

Section A
A.	 1.	 (i)	 2.	 (ii)	 3.	 (iii)	 4.	 (ii)	 5.	 (i)
	 6.	 (ii)	 7.	 (ii)	 8.	 (iii)
B.	 1.	 nine	 2.	 Go to	 3.	 Sound	 4.	 Home page	 5.	 Internet
C.	 1.	 T	 2.	 T	 3.	 F	 4.	 T	 5.	 F

D.	 1.	 			   i.	  Reading view

	 2.	 			   ii.	 Slide Show

	 3.	 			   iii.	  Normal view

	 4.	 			   iv.	 Slide Sorter view

	 5.	 			   v.	 Outline view button

Section B
A.	 1.	 PowerPoint 2016 is a program that allows you to create interesting and exciting presentations. 
	 2.	 The ability of the brain to use and understand visual information from the environment is 

referred to as visual processing.
	 3.	 ARPA set up a network of computers between different offices of defence department 

to exchange and share important information. This network of computers was called the 
Advanced Research Projects Agency Network or ARPANET. 

	 4.	 It uses AI to act as a personal assistant helping the user remember tasks, create appointments, 
and search for information by voice. 
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B.	 1.	 Slide layout refers to the formatting and positioning of placeholder boxes for the content 
that appears on a slide.

	 	 PowerPoint 2016 includes nine built-in slide layouts:
	 	 Title Slide layout, Title and Content layout, Section Header layout, Two Content layout, 

Comparison layout, Title Only layout, Blank layout, Content with Caption layout, and Picture 
with Caption layout.

	 2.	 You can use the say block from the Looks category. The say Hello! for 2 seconds block will 
make the sprite display “Hello!” in a speech bubble for 2 seconds.

	 3.	 Microsoft Edge is the default web browser in the Windows 10 operating system. Current 
tabs, Address bar and Refresh are the parts of Microsoft Edge.

	 4.	 It uses a natural language user interface to infer, observe, answer, and give recommendations 
to users. 


